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17.05.18

Design

When generating the interface file for the design with NaZwei it could happen, that the
file path was read-only (installation directory) and that this caused the termination of the
design.

12612

25.04.18

Output document

The elastic resistance moment is internally always calculated and logged for userdefined girder section, even if a calcualtion according to the elastic-plastic method is
admissible.

12518

19.03.18

Analyses

In the slip circle analysis, support forces due to stiffenings are now treated as the same
load group as the anchor forces.

12403

19.03.18

Analyses

Shear force transfer in the lock jaw of a sheet pile
The hitherto approach for the calculation of the necessary number of grouting points for
the shear force transfer in the lock jaw of a sheet pile was based on the dimensioning
with the maximum shear force.
With the new, more efficient, analysis method, the allotted total shear force per shear
area with the same sign is determined by integrating the shear force to a resultant and
distributing it onto all grouting points which results in the necessary number of grouting
points. Thus, the plastic redistribution of the grouting point forces is being considered.

12286

19.03.18

Calculation

The numeric calculation of the earth resistance according to Gudehus has been
incorporated.

11799

19.03.18

Calculation

Up to 1000 circles can now simultaneously be calculated in the slip circle analysis.

11741

19.03.18

Design

Consideration of the thickness reduction due to corrosion in the design of sheet
12279
pile walls
The hitherto approach, in which the resistance moment and the cross-section area of the
sheet piles are reduced proportionally to the average value of the wall thickness losses
was too far on the safe side for many cases.
With the new approach, the reduction of the stiffnesses is calculated by subtracting the
areas, respectively, the resistances of the rusted subareas. This causes more efficient
design results.

19.03.18

Design

Individual sheets can now be designed for the sheet pile sections. For this, an individual
sheet can be added via the user-defined section input by defining the geometrical and
statical values manually. Then the option "Design as individual sheet" can be selected
under "Wall properties" in the design options. Additionally, the sheet width to be
designed has to be specified in order to reduce the design stress resultants (which are
usually calculated per running meter of the wall) for the individual sheet.

12131

19.03.18

Design

The result list for the design of sheet pile wall cross-sections has been extended with the
bearing capacity analysis from shear force action effects. The analysis with interaction of
bending and shear force can only be performed, if the shear force analysis is fulfilled.

12094

19.03.18

Design

An arbitrary number of single loads can now additionally be applied onto the bracing.

11601

19.03.18

Design

The design of the bracing can be carried out under the consideration of an additional
user-defined normal force.

11599

19.03.18

Input

The infilling piles of a secant pile wall can now also have a different diameter than the
main piles.

11711

19.03.18

Input

The user-defined specification of the wall dead load is possible again.

11709

19.03.18

Output document

The calculated pile reinforcement from the results of the bending design has to be
interpreted as total reinforcement per pile cross-section and is thus issued with cm² as
unit.

12142

19.03.18

Calculation

The embedment depth could not be zeroized for an unconstrained base.

11053

19.03.18

Design

In the analysis of the shear force transfer in the sheet pile wall locks, the shear force to
12095
be transferred was determined from the decisive design stress resultants for the
maximum utilization in the sheet pile wall design. This did not always result in the highest
shear force. Now, the maximum shear force over all nodes of the stage design is used
for this analysis.
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19.03.18

Design

The section-by-section design sometimes malfunctioned for a negative origin of the zordinate.

11852

19.03.18

Design

The calculation of the shear force bearing capacity without shear reinforcement VRd,ct in 11743
the shear force design of circular cross-sections has been adjusted to the literature
recommendations by "Bender + Mark" by applying 0,5*As,tot/Ac for the longitudinal
reinforcement ratio. The static effective height d is hereby relating to the tensile force
centroid and the value d in eq. (6.2) of the EN is replaced by the inner lever arm z. An
increase of the limit load due to compression forces is still calculated via the concrete
stress as in eq. (6.2) of the EN.

19.03.18

Design

The normal force graph was wrongly dimensioned at the maximum positions.

11376

19.03.18

Input

The user-defined input of the moment of inertia, the area as well as of the shear area is
possible again.

11708

19.03.18

Input

In the section-by-section input of the cross-sections did the elevation in the input not
correspond with the displayed values.

11707

19.03.18

Input

The partial safety factors for the point-bearing pressure and the skin friction can now be
specified for the analysis of the transfer of the vertical forces.

10606

19.03.18

Output document

The bedding stress values Apx were sometimes et to zero in the earth static analysis for
a horizontally displaceable wall with bedding and the selected option "Earth resistance in
front of the base as beg. loading onto the structural system". This option does not make
sense with an existing bedding and is now automatically inactive.

10608

19.03.18

User interface

The dialog "Design options" can now be enlarged / reduced and the selected size will be
saved.

12118

19.03.18

User interface

The z-ordinate was incorrectly stated in the design options for a shifted coordinate
system and an upward facing z-axis.

12037

19.03.18

User interface

Was the geometry of an anchor retroactively modified, then the selected anchor
properties were lost.

11980

19.03.18

User interface

Instead of "z-Pos" the wrong labeling "y-Pos" appeared at several places.

11866

19.03.18

User interface

Were special characters such as '<', '>' in the project name, then no graphs were
generated in the dialog "Design options" and in the result list.

11721
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05.07.17

Design

The stress resultants and reinforcement amounts were gradually increased and
superimposed with the previous results when repeatedly calling the design preview from
the design dialog. The design is now restarted completely after each call of the design
preview, there is no more interaction with the previous calls.

11573

05.07.17

Design

In the design of the bracing, the span lengths and cantilever lengths of the continuous
beam can now be specified by the user or be modified. This is also possible, if userdefined coordinate systems are being used.

11572

03.07.17

Calculation

For some static systems the normal forces from permanent loads were calculated into
11340
the normal forces from variable loads. Thus, the cross-sections were over-dimensioned.
The stress resultants from love loads were sometimes no longer graphically issued in the
output document, even though the table of values was always calculated and displayed
correct. In this cases in could happen, that those parts had no influence on the design
stress resultants.

29.06.17

Design

The result list for the design of steel cross-sections has been extended with the bearing
11536
capacity analysis from shear force action effects. The analysis with interaction of bending
and shear force can only be performed, if the shear force analysis is fulfilled.

29.06.17

Input

Double U-sections are now possible for the bracing.

11286

29.06.17

Output document

An envelope of the maximum required reinforcements amounts can be issued for the
design of reinforced concrete cross-sections. It corresponds with the run of the
maximum reinforcement amount over all construction states.

11466

29.06.17

Output document

Instead of the separation of the required reinforcement amounts into the earth (as1) and 11283
air (as2) side a total reinforcement, which has to be distributed evenly over the entire pile
cross-section, is now issued in the design of bored piles.

29.06.17

Analyses

Twice the section width of a U-section is now applied for the determination of the spatial
earth pressure in the calculation of the earth resistance in front of small compressed
areas for girders with a double U-section.

11540

29.06.17

Analyses

In the analysis of the vertical load transfer of soldier pile walls, the full definite girder
cross-section is used by default for the calculation of the contact area according to EAB.
Alternatively, the contact area can be specified by the user.

11508

29.06.17

Calculation

The cross-section values of wired anchors have been corrected.

11436

29.06.17

Design

Are single anchor layers positioned at the same support over several construction states, 11507
then the bracing design is carried out analogously to the anchor design via the automatic
determination of the design relevant construction state. Then only the maximum resulting
anchor force or the shear force offset from all construction states is offered as design
force for the analysis of the bracing.

29.06.17

Design

The stability analyses are calculated between bracing point, earth support and free end
for all spans with the corresponding stress resultant combinations and supposed fork
support. The decisive span with the corresponding maximum utilization level is issued.
Euler case 1 is applied as decisive buckling length for restrained walls.

11477

29.06.17

Design

For staggered cross-sections (or wall types) all cross-sections were designed at the
same design node.

11438

29.06.17

Design

In the output of the required reinforcement amounts the sides were interchanged. The
earth side was issued as soil side and vice versa.

11363

29.06.17

Design

Cross-section values were not always saved after a modification.

11362

29.06.17

Output document

Modified height levels were not transferred to the list of the design results.

11284

29.06.17

User interface

The input menu could no longer be displayed and edited for a contiguous bored pile wall
with a curved bracing.

11341

29.06.17

User interface

The lowermost soil layer was no longer issued and displayed after a calculation.

11307
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06.04.17

Analyses

The parameters "Limit skin friction" and "bearable point-bearing pressure" can no be
specified for each soil layer in the analysis of the transfer of the vertical load into the
subsoil, so that no longer the average has to be determined and entered for stratified
soils.

9288

06.04.17

Design

The design module has been revised and renewed completely. The external design
program WWdim has been disestablished and been replaced by an internal design
module. This considerably enhanced the handling for the design. An interaction between
settings and results on the one side as well as the design settings and results on the
other side is now possible at any time, without having to subsequently open an external
design program. The scope of work corresponds with the one from WWdim, enhanced
with some new innovative functions:
1. revised section database according to the current manufacturer's tables for sheet
pile walls and steel section girders
2. user-defined materials, sections and cross-sections can be defined easier
3. automatic suggestions of a sections with internal design for the quick crosssection selection
4. analysis of the steel and concrete cross-sections according to the current
standards (EC 2 and EC 3)
5. ULS and SLS analyses for horizontal timber sheeting, sheet pile, bored pile and
diaphragm walls
6. graphic display and output pf the selected wall types with the relevant geometry
and design data
7. wall type and wall geometry can be varied and designed with the depth (e.g.
combination of in-situ concrete wall with put on horizontal timber sheeting)
8. stage design for all points of support and construction states
9. chord design with variable static systems (one to seven-span girder, lever arms),
variable span lengths for the simulation of the anchor failure and variable load
modeling optionally for each anchor position
10. revised anchor database corresponding with the specifications of the common
manufacturers, variable anchor selection and design possible for each anchor
layer
11. only the decisive design spots and results with the highest utilization are issued
due to a smart design filter
12. the simplified stability analyses have been replaced by the common, standardized
and precise analyses (buckling, flexural and lateral torsional buckling)
13. cross-section weakening due to rusting can be considered for all steel
components
14. crack width analysis for concrete cross-sections optionally by direct calculation or
with the indirect method

11216

06.04.17

General

Update of the material database
The steel types for hot-rolled sheet piles according to DIN EN 1993-5 have been added
to the material database.

6211

06.04.17

Output document

Favorably acting single loads onto the wall through live loads were not listed in the
vertical analyses.

9872

06.04.17

User interface

Earth pressure options can either be defined separately for each construction state or
matched over all construction states via an additional option.

9179

06.04.17

Calculation

The design stress resultants for a bedding with a horizontally fixed base were sometimes 10232
incorrect.

06.04.17

Design

The option "Laterally NOT fixed" was not considered for a bracing with the property
"Spring" or "Rotation spring".

9178

06.04.17

Output document

The dimensioning of the system graph was misleading for varying wall lengths in the
different construction states.

9988
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01.12.16

Calculation

The hydraulic base failure can now also be calculated without the active option "parallel
circulation". Hence, both the combination 'static water pressure + hydraulic base failure'
and the combination 'dynamic water pressure + hydraulic base failure' are optionally
analyzable.
The partial safety factor for the stabilizing actions of the hydraulic base failure have
wrongly been in the category EQU and could not be edited.
The partial safety factors for the limit state of safety against displacement (EQU) have
been removed from the dialog, because they are not necessary. The partial safety
factors for the hydraulic base failure (HYD) are now displayed in a separate dialog.

10592

01.12.16

Calculation

The vertical part of a negative horizontal C force was applied incorrect in the vertical
analysis.

9893

09.02.16

Analyses

The anchor properties have been extended with the manual input of the limit force. The
design value of the pull-out resistance of the anchor is to be considered as limit force.
Is no manual input made, the design value of the pull-out resistance is still calculated
with the skin surface of the grouting body and the limit skin friction of the present soil
layer.

9289

09.02.16

Calculation

If the ground inclination on the earth side exceeds the friction angle of the present soil,
an earth pressure calculation according to DIN 4085 is no longer possible by definition.
In such cases the earth pressure calculation can lead to implausible and unrealistic
results, which is why a warning message is now issued at the beginning of the
calculation.
Hereupon the earth pressure distribution should be reviewed critically. It is suggested to
compare with the numerical earth pressure distributions according to the CULMANN
method in these cases.

9287

09.02.16

General

Program modifications for the compatibility with Windows 10.

9537

09.02.16

Input

The range of the permeability coefficients for soil layers has been extended to 10^-8.

9142

09.02.16

Analyses

The vertical part of inclined bracings was not considered in the vertical analyses for walls 9264
with restraints.

09.02.16

Calculation

The support forces of the bracers were not considered in the slip circle analysis.

09.02.16

Calculation

For the handling of the pre-deformations a control section has been added to the
9360
calculation options. This is called "apply pre-deformations for live loads".
Case 1: Option has been enabled:
The pre-deformations from permanent and variable actions are calculated separately. In
the subsequent construction state these are added as pre-deformations to the
deformations calculated in the current construction state, by still differing strictly between
permanent and variable situation. Pre-deformations from permanent actions are thus
only superposed with the current deformations from the permanent actions. The same
applies for the variable situation.
Case 2: Option has not been enabled:
The pre-deformations from permanent and variable actions are calculated separately. In
the subsequent construction state these are added as pre-deformations to full load and
are only superposed with the deformations from permanent actions in the current
construction state. The part of the deformations from variable actions is hence never
superposed with parts of the pre-deformation from previous construction states.
!!! Please note:
This case distinction is necessary for the case, that the calculation is carried out with
elastically prestressed anchors. Since the prestressing force is specified as full load, a
distinction between permanent and variable action is not possible there. Therefore a
partition of the pre-deformations in permanent and variable parts and their separate
consideration is no longer possible. Thus, case 2 has to be selected at all times when the
calculation is to be carried out with elastically prestressed anchors. In all other cases a
partition of the pre-deformations into the permanent and variable situation can be done
and case 1 can be applied.

09.02.16

Calculation

Were soil layers modified in only one construction state, then the wrong delta.p was used 9298
for the earth resistance calculation in the analysis for the safety against heaving of the
anchorage soil.
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09.02.16

Calculation

The automatic selection of soil layers to the left and to the right of the sheeting wall at the 9297
same time has been disabled, since errors in the earth pressure calculation could occur if
soil layer parameters were only adjusted in one construction state.
Are soil layers provided with different parameters in different construction states, this is
displayed separately in the tree view.

09.02.16

Calculation

For a live line load without any additional permanent loads sometimes the program
terminated.

9123

09.02.16

Calculation

In the vertical analysis according to EB 9 "Analysis of the vertical components of the
activated earth resistance" the vertical part of earth pressures, anchors and supports
(bracers) due to live loads was also applied if these were acting favorable (upward).
In the analysis according to EB 84 / 85 "Transfer of vertical loads in the subsoil" no
differentiation was made between favorable (upward) and unfavorable (downward)
actions.

7553

09.02.16

Input

In a special soil layer model the soil was not separated correctly at a polygonal soil layer
boundary, whereat this only occurred after saving and reopening the file.

9324

09.02.16

Output document

An alternative analysis like with a horizontally displaceable foot cannot be carried out for
an unsupported foot in the vertical analysis. Contradictory information in the output
document when exceeding the utilization level has been removed.

9456

09.02.16

Output document

Was only a bracing entered and not an anchor, then no bracing forces were issued in the 9301
output document.
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26.05.15

WWDim

Now, also the design with glass fiber reinforcement is possible.

6897

26.05.15

Calculation

The standard earth pressure calculation with a 90° slope was incorrect.

9049

26.05.15

Calculation

If the ground level was above the crest (e.g. for a slope), an existing cohesion was
possibly considered incorrectly in the earth pressure calculation.

9031

26.05.15

Calculation

If the ground level was below the crest on the right side, then it was wrongly redistributed 9027
up to the crest for an earth pressure calculation according to Culmann.

26.05.15

Calculation

The calculation of Edu (Earth resistance in front of closed wall) as comparison for the
calculation of the earth resistance in front of small compressed area is no longer carried
out with a reduced 'c' for cohesive soils.

26.05.15

Calculation

The reduction of the equivalent widths for the friction force (bsR), the cohesion (bsK) and 9010
the critical compressed wall width (bkR) can now be switched off for the earth resistance
in front of small compressed areas, whereby the earth resistance is increased.

26.05.15

Calculation

If a retreating state and an infinite permanent line load but no block load existed, then the 9005
horizontal loading for permanent and live loads was not superimposed below the base
for Blum in the previous construction state. This caused different results in the design
stress resultants and therefore also in the design.

20.04.15

Design

The vertical analysis according to EB 84/85 is now also carried out for a horizontally fixed 8947
wall.

20.04.15

Calculation

The cohesion in the ground offset was possibly not considered for a slope on the side of
the earth resistance with cohesion, so that too small earth resistance values resulted.

8958

20.04.15

Calculation

The water pressure above the ground level was applied incorrectly (too small) for a free
water level on the right and pervious soil at the same time, as if there was also a soil
layer with the permeability coefficient k>0.

8618

20.04.15

Calculation

A restraint in direction of the section was also applied when selecting the wall top support 8491
"hinged" and not only a hinged section as expected, so that unexpected normal force
could arise there.

20.04.15

Output document

Was BS-T/A(2/3) selected as design load cases, a wrong text was issued under results
construction state headline in the result list.
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20.04.15

Output document

Even if no anchor analysis was required it was still issued incorrectly in the result list.

8937

20.04.15

Output document

Specified kh values were not issued in the result list for soil layers only adjusted in one
construction state.

8291

20.04.15

User interface

The associated settings in the calculation options were not adjusted when deleting a
construction state.

8847

04.03.15

Analyses

The analysis of the terminated cracking under CSN EN standards is performed on the 8831
basis of the general EN 1992-1-1 again, whereupon the coefficient k3 for the calculation
of the crack spacing sr,max is calculated according to a change (2015) in the national
annex of the CSN EN.

04.03.15

Output document

The height notation of the excavation depth was missing in the CAD output.

8639

04.03.15

Calculation

There were problems for earth pressure at rest and active, respectively, increased earth
pressure when changing the type of earth pressure redistribution. A selection of the
different options was possible, however the option "Redistribution up to the base of
excavation" was always used for the calculation.

8559

04.03.15

Calculation

Vertical analysis according to EB 84/85
8421
The vertical substitute force Cv was applied in the wrong direction for the affecting forces
(Vd). In contrast, Cv has been doubly used for the design value of the resistance.

04.03.15

Calculation

The deformations were calculated from full load (g+p) and not separately for permanent
and non-permanent loads when applying column settlement.

8255

04.03.15

Calculation

The transfer of the soil engineering standard to the slip circle analysis malfunctioned.
The slip circle was always calculated according to DIN 1054:2005 independently from
the standard settings in the program.

8142

04.03.15

Calculation

The vertical bedding stresses on the excavation side were not considered in the vertical
analysis for horizontal timber sheeting walls.

7552

04.03.15

Output document

An infinite constant load was displayed with differing heights in the system plot when a
8727
slope existed. Furthermore, a load classified as live load was issued as dead load (g=...).

04.03.15

Output document

The texts of the soil layers were outside of the soil body in the CAD output.

8721

04.03.15

Output document

Sometimes incomplete images were generated in the result lists, which caused a
termination of RtPrint or large grey spots in RtConfig.

8416

04.03.15

Output document

The unit of the line loads has been corrected to kN/m.

8415
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23.06.14

Analyses

Only a value between 10 an 80 kN/m² could be entered in the calculation options for the
skin friction in the vertical analysis. This limitation has been removed.

8118

23.06.14

Calculation

In the analysis of the "Resistance of the earth support" "Analysis fulfilled" has been
displayed for a difference < 3% between Eph,d and Uh,d, although the analysis was not
fulfilled.

8054

23.06.14

Output document

If more than one user-defined profile had been entered in the userprof.dat, these were
imported incorrectly in RTwalls.

8087

23.06.14

User interface

The display of the value of the height notation for bracings became incorrect in the lower
input menu and the dialog, if the z-coordinate pointed upward.

8051

26.03.14

Analyses

There were errors in the analysis of the safety against raise of the anchorage soil:
- the option "set delta.a = 0" had no effect
- there is now the new option for the earth resistance "set delta.p=0"
- block loads were not considered

7602

26.03.14

Calculation

The horizontal analysis was incorrect for a user-defined earth resistance, which is
defined below the base point of the wall, and selected foundation modulus method.

7874

26.03.14

Calculation

The earth pressure due to block loads was not considered for the horizontal analysis in
the earth pressure calculation according to Culman.

7860
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26.03.14

Calculation

In the earth pressure calculation according to Culman with an additional user-defined
earth pressure, the user-defined earth pressures were not considered in the horizontal
and vertical analysis.

7858

26.03.14

Calculation

In the earth pressure calculation with live loads according to Culman, the part of the
earth pressure due to live load has not always been calculated correctly.

7848

26.03.14

Calculation

If the ground level was below the crest, the bend in the earth pressure distribution was
missing for an existing slope.

7815

26.03.14

Calculation

The earth pressure due to the slope was peculated for an embankment.

7555

26.03.14

Input

The corresponding earth pressure as well as redistribution options for the active earth
pressure and the earth pressure at rest were only adjusted in the options for the
construction state after closing and reopening the dialog.

7742

26.03.14

Input

Are soil layer edges present in construction state '0', which basically hover in a different
construction state due to a lower surface level, the calculation was incorrect. Now, these
soil layers are being ignored in the calculation.

6881

26.03.14

Output document

An incorrect "/2.00" was issued in the result list for the earth resistance in front of small
compressive areas if the new standard was selected and the clear blank spacing was
smaller than the embedment depth. The calculation was correct.

7808

23.01.14

Calculation

When switching to earth pressure at rest the option for the redistribution is automatically
changed. Now, the previous redistribution condition is restored when switching back.

6848

23.01.14

Analyses

For complex systems with retreating states in which anchors are removed, it could occur
that the analysis of the safety against pulling out provided incorrect results.

6914

23.01.14

Calculation

For Deltap == Default, deltap was set to 0 in the calculation of the earth resistance
according to Gudehus.

7427

23.01.14

Calculation

If the origin of the coordinate system was above ~800m, the slip circle analysis
malfunctioned.

7426

23.01.14

Calculation

In the analysis of the transfer of the vertical forces according to EAB 85, the effective
contact area was calculated incorrectly for pile walls.

7228

23.01.14

Calculation

Earth pressure at rest coefficient according to DIN 4085-100 was incorrect, if the wall
friction angle delta was greater than the surface inclination beta.

7222

23.01.14

Calculation

Vertical, negative slopes have no longer been considered for earth pressure and earth
resistance.

7215

23.01.14

Calculation

Earthquake
There is a new option: Consider water - yes / no. Furthermore, the polygonal distribution
of the loading due to water and earthquake is simplified as triangle.

7092

23.01.14

Calculation

If the direction of the z-ordinate is upwards, the z-ordinate was issued incorrectly when
selecting the result drawings in the user interface.

7065

23.01.14

Calculation

Problems in the FE kernel could occur, if sections were selected in the database whose
cross-section values were 0. Thus, the database has been edited.

6836

23.01.14

Design

The amount of lines on one page could not be changed in WWDim. Therefore, the
printout was limited to one page and thus incomplete.

7226

23.01.14

Output document

All misleading dimension information with the text "per running meter" have been
removed.

6953

23.01.14

User interface

The option "soil layer lense" has been removed from the context menu "soil layer edge".
This option had no influence on the calculation.

7064

23.01.14

WWDim

The cross-section areas for the ARCELOR Sheet pile wall profiles PU 12, PU 1210/10, as well as all cross-section values of the PU 28+1 profile were corrected in the
profile database.

7281
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05.11.13

WWDim

For the design of the anchor systems in WWdim, a database with prevalent anchor
systems has been added. Now, an anchor with the stored anchor data can be selected
for the design from the database.

7174

05.11.13

Calculation

Ag,k Aq,k and E,d were no longer displayed or were equal to 0 in the analysis for the
safety against pulling out of a grouted anchor.

7182

05.11.13

Output document

In the CAD Plot Loading, characteristic the redistributed earthpressure according to Blum 7179
was issued with the partial safety factor (design value).

05.11.13

Output document

The design results were missing in the system plot in the CAD output.

7149

04.09.13

Output document

When opening RTprint in WWDim, special characters and umlaut were not displayed
correctly.

7043

30.07.13

Analysis

Vertical analysis according to EAB Eb 84, 85:
6254
- if the bored pile diameter was specified for a bored pile wall, this wasn't logged in the
list
- if a contiguous bored pile wall was defined and previously a sheet pile wall or a soldier
pile wall with a specified cross-section had been selected, the specified cross-section
remained
- for 1*U-sections the developed skin surface was calculated wrong. Now: Skin surface =
Web + 3*Flange
- the unit for the result of the characteristic point-bearing pressure was wrong

30.07.13

Calculation

In the 5th edition of the EAB, the contact area of sheet pile walls can no longer be
calculated with the angle alpha, but the steel area has to be used. Now, either a userdefined Ab or the area of the selected section from the database is used.

6644

30.07.13

Analysis

The printout was incorrect, if live loads existed only on the side of the earth resistance.

6563

30.07.13

Calculation

If a live load existed in one construction state and no longer in the consecutive
construction state, then the live load portion was wrongly taken into account.

6948

30.07.13

Calculation

In the calculation of the earth resistance coefficient for earthquakes, kvEQ was specified
as (1+kvEQ) instead of (1-kvEQ) in the formula. This resulted in slightly increased
coefficients and a too high earth resistance.

6847

30.07.13

Calculation

Earth pressure for vertical slopes malfunctioned.

6800

30.07.13

Calculation

If "Consider dead load" under "Options->Loading->Earth pressure" was disabled, while
the earth pressure calculation according to Culman was enabled, then the horizontal
force analysis was wrong.

6786

30.07.13

Calculation

The earth resistance was increased instead of reduced when earth resistance and
ground inclination > phi.

6785

30.07.13

Output document

In the scaled plot output for the new and old standard, only the corresponding plots are
issued.

5418

30.07.13

WWDim

In WWDIM it is possible to open and edit the user-defined section file via the function
"File->Show user-defined section file".
But wrongly the file in the installation
(c:\Programme\rib\ribtec\win\Grund\Rtwalls\WWDIM) has been used. Now, the correct
file "userprof.dat" from the user directory is used.

6288

09.04.13

Analyses

The analysis of the pull out resistance can now be carried out optionally in LC1, even if
the corresponding load case is calculated in a different load case.

6153

09.04.13

Analyses

A point of zero shear force can now be specified for the analysis in the deep sliding joint
(Options -> Anchor). In the case of a double zero point, the lower value is used for the
analysis in the deep sliding joint by default -> the result is on the safe side, but
sometimes provides too long anchors.

6152

09.04.13

Calculation

The different deformation behavior of soldier piles and soil in the calculation of soldier
pile walls is now also considered for partially restrained walls according to BLUM by the
matching coefficient (eta,Ep) according to EB 25.

6338
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09.04.13

Calculation

The application of negative wall friction angles for the earth pressure calculation is now
possible and is considered in the vertical analysis.

6147

09.04.13

Calculation

The design with WWDim is now also possible if only one construction state out of
multiple construction states has been calculated.

5486

09.04.13

Calculation

It is now possible to specify different earth pressure options, such as earth pressures
(active, increased active, earth pressure at rest), in different construction states.

5360

09.04.13

General

Now, the release notes are available in English.

6448

09.04.13

General

Program modifications for the compatibility with Windows 8.

6359

09.04.13

WWDim

In WWDim, the wooden infilling is now designed based on EN 1995. Specifically, these 6141
are:
1. Bending, where applicable with normal force
2. Shear force
3. Bearing stress

09.04.13

Analysis

Incorrect calculation of the buckling length for the design with WWDim if the origin of the
coordinate system is unequal to 0 in the y direction.

6472

09.04.13

Calculation

The function to edit soil layers for each construction state did not always work, if the
origin of the coordinate was moved in z-direction.

6558

09.04.13

Calculation

Earth pressure calculation for block loads with vertical step of the ground. The load
remains unchanged, but the earth pressure due to the load changed a bit, although the
ground was not within the area of influence.

6160

09.04.13

Calculation

If several loads were exactly the same, all but one have been eliminated after the
calculation.

5493

09.04.13

General

Problems with the data path (a path length > appr. 130 characters led to an abnormal
termination when opening the result list).

6171

09.04.13

User interface

When editing the ground level by clicking the dimension line, the ground level is changed 6162
in all construction states without inquiry.

09.04.13

User interface

No earth layer data or incomplete earth layer data had been provided In the bottom
menu. The bottom menu for the wall properties has been extended .

5516

09.04.13

User interface

After opening the result list and if the z-direction of the coordinate system was upward,
then the direction of the coordinate system was inverted according to the display of the
height notation. It was just a refresh problem.

5484

09.04.13

WWDim

For a sheet pile wall design according to EC3 the design was not listed in the plot output! 6178
(maxM=minM=maxQ=0 )

09.04.13

WWDim

2xU-section is now handled correctly.
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